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FEATURES 
Fully featured evaluation board for 10-lead precision ADCs 
Versatile analog signal conditioning circuitry 
On-board reference, reference buffers, and ADC drivers 
PC software for control and data analysis of time and 

frequency domain 
System demonstration platform-compatible (EVAL-SDP-CH1Z) 

EVALUATION BOARD KIT CONTENTS 
AD4000/AD4001/AD4002/AD4003/AD4020 evaluation board  

(see Table 7) 
12 V wall adapter power supply 

EQUIPMENT NEEDED 
SDP-H1 board (EVAL-SDP-CH1Z) 
Precision signal source 
Cable (SMA input to evaluation board) 
Standard USB A to mini-B USB cable 
Band-pass filter suitable for 16-bit, 18-bit, and 20-bit testing 

(value based on signal frequency) 
AD40xx evaluation software 

GENERAL DESCRIPTION 
The AD4000/AD4001/AD4002/AD4003/AD4020 family 
evaluation board covers the ease of use, 16-/18-/20-bit, 
precision successive approximation register (SAR) analog-to-
digital converters (ADCs). The AD4000/AD4001/AD4002/ 
AD4003/AD4020 are low power, 16-bit/18-bit/20-bit, precision 
SAR ADCs that offer very high performance with throughputs 
up to 2 MSPS (1.8 MSPS for the AD4020). The evaluation board is 
designed to demonstrate the performance of the AD4000/ 

AD4001/AD4002/AD4003/AD4020 family of ADCs and to 
provide an easy to understand interface for a variety of system 
applications. A full description of these products is available in 
their respective data sheets, which must be consulted when 
using this evaluation board. 

The EVAL-AD4000FMCZ/EVAL-AD4001FMCZ/EVAL-
AD4002FMCZ/EVAL-AD4003FMCZ/EVAL-AD4020FMCZ 
evaluation boards (see Figure 1) are ideal for use with the Analog 
Devices, Inc., high speed system demonstration platform 
(EVAL-SDP-CH1Z). These evaluation boards interface to the 
SDP-H1 board via a 120-pin connector. SMA connectors, JP2 
and JP3, are provided for the low noise analog signal source. 

On-board components include a high precision buffered band gap 
5.0 V reference (the ADR4550), a reference buffer (the ADA4807-1), 
a common-mode buffer (the ADA4807-1), a signal conditioning 
circuit with two op amps (the ADA4807-1), and a power supply to 
derive the necessary voltage levels to supply all voltage needs. 

The EVAL-AD4000FMCZ, EVAL-AD4001FMCZ, EVAL-
AD4002FMCZ, and EVAL-AD4003FMCZ are populated with 
the AD4000, AD4001, AD4002, and AD4003, respectively. 
However, these boards can be used to evaluate the performance 
of the AD4004, AD4005, AD4006, AD4007, AD4008, AD4010, 
and AD4011 by limiting the sample rate in the evaluation 
software to the maximum sample rate of the specific ADC. 
For example, the AD4000 on the EVAL-AD4000FMCZ can be 
used to evaluate the performance of the AD4004 if the sample 
rate is limited to 1 MSPS. See the data sheet of each product for 
its corresponding evaluation board. 
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Figure 1. 
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EVALUATION BOARD HARDWARE 

EASY TO USE AD4000 SERIES 16-BIT/18-BIT/20-BIT
PRECISION SAR ADCs EVALUATION BOARD
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Figure 2. Simplified Evaluation Board Block Diagram 

SETTING UP THE EVALUATION BOARD 
Figure 2 shows the simplified evaluation board block diagram. 
Figure 26 shows the evaluation board schematic. The board 
consists of the ADC, U1, with a reference, U6 (ADR4550), and 
ADC drivers, U12 and U14, the ADA4807-1 for the AD4001/ 
AD4002/AD4003/AD4020 and the ADA4805-1 for the AD4000 
(see Table 6). The user also has an option to populate U2 with a 
low power, fully differential ADC driver such as the ADA4940-1 
when evaluating the AD4001/AD4003/AD4020. The evaluation 
board is a flexible design that enables the user to select components 
in addition to operating from an adjustable bench top power 
supply. 

POWER SUPPLIES 
The system demonstration platform (SDP-H1) board supplies 
12 V to power the necessary rails for the AD4000/AD4001/ 
AD4002/AD4003/AD4020 evaluation board. 

Table 1. Power Supplies Provided on the Board 
Power Supply (V) Function  Components Used 
5, 7 (default)1 Positive rail ADP7118 

−5, −2.5 (default)1 Negative rail ADP2370, ADM660, 
ADP7182 

1.8 ADC power ADP7118, ADP5300 
3.3 VDRIVE (digital power) ADP7118 

 
1 See Table 2. 

 

 

 

The 7 V amplifier positive rail (+VS) is generated from U17 (the 
ADP7118). The −2.5 V negative amplifier rail (−VS) is generated 
by a combination of U3 (the ADP2370), U7 (the ADM660), and 
U21 (the ADP7182). 

Each supply is decoupled where it enters the board and again at 
each device. A single ground plane is used on this board to 
minimize the effect of high frequency noise interference.  

In addition, there is also the ability to power the board from a 
bench top power supply. The screw terminals, J2 and J3, are 
provided for this function. When bench power is used, the on-
board power supplies are no longer required. The solder links also 
must be changed: SL1 = SL2 = SL5 = SL6 = SL7 = SL8 = SL9 = B. 

REFERENCE, REFERENCE BUFFER, AND COMMON-
MODE BUFFER 
An external 5 V reference (U6, ADR4550) is used by default to 
supply the ADCs directly. However, the user can also use one of 
the 2.5 V, 3.3 V, and 4.096 V references by changing the reference 
device on the board (U6, ADR4525/ADR4533/ADR4540). There is 
also an option to use a lower power reference (U22, ADR3450). 
Note that the ADR3450 cannot accept input voltages beyond 5.5 V. 
The ADA4807-1 is used as a reference buffer (U16) and common-
mode buffer (U18) by default. However, it can also be replaced by 
the AD8031 if needed without compromising the performance. 
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SDP-H1 CONTROLLER BOARD 
The evaluation board uses a serial port interface (SPI) and is 
connected to the high speed controller board for the system 
demonstration platform (SDP-H1) controller board. The SDP-H1 
board requires power from a 12 V wall adapter. The SDP-H1 has a 
Xilinx® Spartan 6 and an ADSP-BF527 processor with connectivity 
to the PC through a USB 2.0 high speed port. The controller boards 
allow the configuration and capture of data on daughter boards 
from the PC via USB.  

The SDP-H1 has an FMC low pin count (LPC) connector with full 
differential low voltage differential signaling (LVDS) and singled-
ended low voltage complementary metal-oxide semiconductor 
(LVCMOS) support. It also has the 120-pin connector, found on 
the SDP-B, which exposes the Blackfin® processor peripherals. This 
connector provides a configurable serial, parallel I2C and SPI, and 
general purpose input/output (GPIO) communications lines to the 
attached daughter board. 

SOLDER LINKS 
The three solder link options on the evaluation board are 
configured depending on which generic of the ADC is on the 
specific evaluation board, as described in Table 3. 

Table 2. Jumper Detail with Factory Default Setting 
Link Default Function Comment 
SL1 A +VS Change to B if using bench supplies 
SL2 A −VS Change to B if using bench supplies 
SL5 A +VS Change to B if using bench supplies 
SL6 A −VS Change to B if using bench supplies 
SL7 A VDD for 

ADC 
Change to B if using bench supplies 

SL8 A −VS Change to B if using bench supplies 
SL9 A +VS Change to B if using bench supplies 
LK2 A VREF Change to B if using the ADR3450 
LK5 B SDI Change to A if using V_DRIVE 
JP1 B FSEL (U3) Change to A if using ground 
JP2 B ADC drivers Change to A if using the 

ADA4940-1 fully differential ADC 
JP3 B ADC drivers Change to A if using the 

ADA4940-1 fully differential ADC 
JP4 B ADC drivers Change to A if using the 

ADA4940-1 fully differential ADC 
JP5 B ADC drivers Change to A if using the 

ADA4940-1 fully differential ADC 
JP7 B V_DRIVE Change to A if using external 3.3 V 

for V_DRIVE 
JP8 B STOP (U20) Change to A if using CNV_FMC 

from SDP-H1 connector 

Table 3. Jumpers Specific to 10-Lead Precision ADCs 
Link Default Configuration Generic 
SL4 A Differential input AD4001, AD4003, 

AD4020 
SL4 B Single-ended or pseudo 

differential 
AD4000, AD4002 

 

The evaluation board supports any amplifier mezzanine card 
(AMC). Insert this add on card on the 7-pin headers. Figure 3 
shows the AMC mounted on the evaluation board. The AMC ADC 
driver settings are required to use this option, as shown on Table 4. 
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Figure 3. AMC Installed on the EVAL-AD4000FMCZ 

Table 4. Amplifier Mezzanine Card ADC Driver 
Default Function Comment 
0 Ω (R20, R21), R19 

Do Not Insert 
(DNI) 

AMC ADC driver 
analog positive 
input (VIN+) 

Removed R20 and 
R21 

0 Ω (R20, R21), R39 
DNI 

AMC ADC driver 
analog negative 
input (VIN−) 

Removed R36 and 
R40 

 

ANALOG INPUTS 
The analog inputs to the evaluation board are SMA connectors, J6 
and J10. These inputs are buffered with dedicated amplifier 
circuitry (U12 and U14), as shown in Figure 28. The circuit allows 
different configurations, input range scaling, filtering, addition of a 
dc component, and use of different op amp and supplies. The 
analog input amplifiers are set as unity-gain buffers at the factory. 

The default configuration sets both U12 and U14 at midscale, 
generated from a buffered reference voltage divider (VCM). 

The evaluation board is factory configured to provide either a 
single-ended path or a fully differential path. 

For dynamic performance, a fast Fourier transform (FFT) test can 
be performed by applying a very low distortion ac source. 

For low frequency testing, the audio precision source (such as the 
SYS-2700 series) can be used directly because the outputs on these 
are isolated. Set the outputs for balanced and floating ground. 
Different precision sources can be used with additional filtering.  

Because the evaluation board uses the amplifiers in unity-gain, the 
noninverting input has a common-mode input with a 590 Ω 
resistor divider, and it must be taken into account when directly 
connecting a source. 
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EVALUATION BOARD SOFTWARE 
INSTALLING THE SOFTWARE 
The evaluation board software can be downloaded from the 
EVAL-AD400X-FMCZ product page. 

Install the software before connecting the SDP-H1 board to the 
USB port of the PC to ensure that the SDP-H1 board is recognized 
when it connects to the PC. 

1. Start the Windows® operating system and download the
software from the relevant product page on the Analog
Devices website.

2. Unzip the downloaded file. Run the setup.exe file.
3. After installation is completed, power up the evaluation

board as described in the Power Supplies section.
4. Plug the evaluation board into the SDP-H1 board and the

SDP-H1 board into the PC using a USB cable.
5. When the software detects the evaluation board, proceed

through any dialog boxes that appear to finalize the
installation.

The default location for the software is the following: 
C:\Program Files\Analog Devices\AD40XX Evaluation 
Software\EVAL-AD40XX. 

This location contains the executable software and example files. 

INSTALLATION STEPS 
Proceed through the installation, allowing the software and 
drivers to be placed in the appropriate locations. Connect the 
SDP-H1 board to the PC only after the software and drivers are 
installed. 

There are two parts to the software installation. First, install the 
software related to the evaluation board, as follows: 

1. Launch the evaluation board software installation by
clicking the setup.exe file. The software installation
window opens, as shown in Figure 4. 

14
98

1-
00

2

Figure 4. AD40XX Evaluation Software Install Window 

2. Choose the folder location for installation and click Next.
The default folder is shown in Figure 5.
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Figure 5. Destination Directory Window 

3. Accept the National Instruments software license
agreement and click Next (see Figure 6).
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Figure 6. License Agreement Window 

4. Click Next again to install the software.
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Figure 7. Start Installation Window 
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5. A pop-up window opens and displays a bar showing the 
installation progress, as shown in Figure 8. 
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Figure 8. Overall Progress 

6. Click Next to complete the installation and to launch the 
SDP-H1 driver installation as shown in Figure 10. 
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Figure 9. Installation Complete Window 

The second part of the software installation is the drivers related 
to the SDP-H1 board. These drivers must be installed for the 
evaluation board to function correctly. 

14
98

1-
00

8

 
Figure 10. Beginning of SDP-H1Driver Installation 

1. The ADI SDP Drivers 2.2.95.68 Setup Wizard opens. 
Click Next to install the SDP-H1 drivers. 
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Figure 11. ADI SDP Drivers 2.2.95.68 Setup Wizard Window 

2. Choose the installation location and click Install; the 
default folder is shown in Figure 12. 
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Figure 12. Choose Install Location Window 

3. The installation begins, and a progress bar is displayed. 
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Figure 13. Installing Window 
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4. Click Close to complete the installation. 
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Figure 14. Installation Complete Window 

When you first plug in the SDP-H1 board via the USB cable 
provided, allow the Found New Hardware Wizard to run. You 
can check that the drivers and the board are connected correctly by 
looking at the Device Manager of the PC. Analog Devices 
System Development Platform (32MB) appears under ADI 
Development Tools. 

14
98

1-
01

3

 
Figure 15. Device Manager 

BOARD OPERATION/CONNECTION SEQUENCE 
The following is the board operation/connection sequence: 

1. Connect the SDP-H1 controller board to the evaluation 
board with the J5 connector (screw into place as required). 
The software is configured to find the evaluation board on 
either connector of the SDP-H1 board. 

2. Power the board with the appropriate supply, as described 
in the Power Supplies section. 

3. Connect the board to the PC with the USB cable. 
4. Launch the software. Click Start > All Programs > Analog 

Devices\AD40XX Evaluation Software\EVAL-AD40XX.  
5. Apply the signal source and capture the data. 

 

 

 

 

RUNNING THE SOFTWARE WITH THE HARDWARE 
CONNECTED 
To run the program, take the following steps: 

1. Click Start > All Programs > Analog Devices > AD40XX 
Evaluation Software > EVAL-AD40XX. To uninstall the 
program, click Start > Control Panel > Programs and 
Features > Analog Devices AD40XX Evaluation Software. 

2. The software automatically seeks to find the hardware 
connected; therefore, when no hardware is connected, it 
displays a connectivity error (see Figure 16) when the 
software is launched. Connect the evaluation board to the 
SDP-H1 and connect the SDP-H1 to the USB port of the PC, 
wait a few seconds, click Rescan, and then follow the 
instructions (see Figure 16). 
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Figure 16. SDP-H1 Board Not Connected to the USB Port Error  

3. If Cancel is clicked, a message appears as shown in 
Figure 17. 
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Figure 17. SDP-H1 Board Not Connected to the USB Port Error  

4. The software then connects to the board and displays the 
message shown in Figure 18. 
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Figure 18. Software Connects to SDP-H1 Board 

5. When the board is correctly detected, the software panel 
opens. 
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SOFTWARE OPERATION 
When the software launches, the panel opens and the software 
searches for the hardware connected to the PC. The software 
detects the generic attached to the PC, and the software panel 
then launches as shown in Figure 19. 

DESCRIPTION OF THE USER PANEL 
The following is the description of the user panel. 

The File menu (Label 1 in Figure 19) has the choice of the 
following options: 

 Save Captured Data allows the user to save the current 
captured data for later analysis; the file format is .csv. The 
user is prompted to choose or enter the path of the file in 

the Save As dialog box (see Figure 20). Save to an appropriate 
folder location. 

 Load Captured Data opens the Load File dialog box, where 
the user is prompted to load previously captured data in .csv 
format for analysis. 

 Take Screenshot allows the user to save the current screen 
capture as a .jpg. 

 Print Screenshot allows the user to save the current screen 
capture as a .pdf. 

 Exit stops running the application software. 
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Figure 19. Setup Screen 
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Figure 20. Save As Dialog Box 

The Edit menu (Label 1 in Figure 19) provides the option to 
reset the software to its initial state (Reinitialize to Default 
Values). 

The Help menu (Label 1 in Figure 19) offers information about the 
following: 

 Analog Devices Website 
 User Guide 
 Context Help 
 About 

When hardware is connected to the USB port, the software 
automatically detects which generic is connected and displays it 
(Label 2 in Figure 19). 

The Throughput box is Label 3 in Figure 19. The default value 
is the maximum sample rate that the active device can support 
without turbo mode enabled. The maximum supported 
throughput of 2 MSPS (or 1.8 MSPS for the AD4020) can only 
be achieved by enabling turbo mode (Label 11 in Figure 19). 
If the user enters a value larger than the ability of the existing 
device, the software reverts to the maximum throughput. The 
user can adjust the throughput to a minimum of 10 kSPS. 

The Voltage Reference dropdown menu is Label 4 in Figure 19. By 
default, this reference is 5 V (ADR4550 on-board reference). The 
minimum/maximum voltage calculations are based on this 
reference voltage. If the user changes the reference voltage, this 
input must be changed accordingly. 

Click Single Capture to perform a single capture and click 
Continuous Capture to perform a continuous stream capture 
from the ADC. (Both are noted with Label 5 in Figure 19.) 

Select Samples (Label 6 in Figure 19) to analyze data using the 
particular number of samples. The maximum number of samples 
the software can support is 524,288. 

Four capture tabs (Label 7 in Figure 19) display the data in 
different formats, as follows:  

 Waveform 
 Histogram 
 FFT 
 Summary 

Click Enable Status Bits (Label 8 in Figure 19) to enable the 
content of status header. Status bits can be clocked out at the end 
of the conversion data using six extra clocks when it is enabled. 

Click Span Compression (Label 9 in Figure 19) to enable the 
ADC span compression feature. In single-supply applications, 
the use of span compression increases the headroom and 
footroom available to the ADC driver by reducing the input 
range by 10% from the top and bottom of the range while still 
accessing all available ADC codes. 

Click High-Z Mode (Label 10 in Figure 19) to enable the internal 
high-Z mode. Enabling this mode allows the low input current 
for the ADC and improves total harmonic distortion (THD) 
performance using low power/bandwidth precision ADC 
drivers for slow/dc type signals. 

Click Turbo Mode (Label 11 in Figure 19) to enable turbo mode 
and run the ADC at the full throughput of 2 MSPS.  

Click Read Register (Label 12 in Figure 19) to check if any of the 
ease of use features are enabled, including span compression, 
high-Z mode, turbo mode, an overvoltage condition (which is a 
sticky bit), and the status bits.  

Clicking Enable Status Bits enables the six status bits, and the 
content of the six bits is updated and displayed in the Status 
Header section (Label 13 in Figure 19) after clicking single or 
continuous capture. Note that the overvoltage clamp flag status 
bit updates on a per conversion basis. 

When the Busy indicator (Label 14 in Figure 19) is lit, the user 
must wait until the software completes the data analysis. 

This software allows the user to select the Oversampling Ratio 
(Label 15 in Figure 19) up to 256 from the dropdown menu 
located in the Configure tab. The oversampling capability is 
implemented in the evaluation software by averaging the ADC 
output samples, that is, by summing the number of ADC 
samples and dividing it by the oversampling ratio to obtain the 
increased dynamic range. 

To exit the software, click File > Exit. 

Within any of the chart panels, the tools shown in Table 5 allow 
user control of the different chart displays. 

Table 5. Graphical User Interface (GUI) Tools 
Symbol Description 

This tool controls the cursor, if present. 
This tool zooms in and out. 

This tool is used for panning. 

The evaluation software allows the user to export the raw data 
or image. Right clicking any of the four capture tabs (Waveform, 
Histogram, FFT, and Summary) open the menu as shown in 
Figure 21, and the user can either export the raw data in Excel 
format or save an image in .bmp, .eps, or .emf format. 
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Figure 21. Export Raw Data or Image 

WAVEFORM CAPTURE 
Figure 22 illustrates the waveform capture. The input signal is a 
1 kHz sine wave. The waveform analysis reports the amplitudes 
recorded from the captured signal in addition to the frequency of 
the signal tone.  
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Figure 22. Waveform Tab 
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AC TESTING—HISTOGRAM 
The ac testing histogram tests the ADC for the code distribution 
for the ac input, computes the mean and minimum/maximum 
amplitude and LSB size of the converter. Raw data is captured 
and passed to the PC for statistical computations. To perform a 
histogram test, click the Histogram tab and click Single Capture 
or Continuous Capture. Note that an ac histogram needs a 
quality signal source applied to the J6 and J10 input connectors. 
Figure 23 shows the histogram for a 1 kHz sine wave applied to 
the ADC input and illustrates the different measured values for 
the data captured. 

DC TESTING—HISTOGRAM 
More commonly, the histogram is used for dc testing where the 
user tests the ADC for the code distribution for dc input, computes 
the mean and standard deviation, or transition noise, of the 
converter, and displays the results. Raw data is captured and 
passed to the PC for statistical computations. To perform a 
histogram test, click the Histogram tab and click Continuous 
Capture. Note that a histogram test can be performed without an 
external source using a VREF/2 (590 Ω resistor divider) at the 
ADC input. To test other dc values, apply a source to the J6 and 
J10 input connectors. It may be required to filter the signal to 
make the dc source noise compatible with that of the ADC. 
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Figure 23. Histogram Tab, Histogram Captured for Sine Wave 
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AC TESTING—FFT CAPTURE 
The traditional ac characteristics of the converter can be 
displayed on the FFT tab. As in the histogram test, raw data is 
captured and passed to the PC where the FFT is performed, 
displaying signal-to-noise ratio (SNR), signal-to-noise-and-
distortion ratio (SINAD), total harmonic distortion (THD), 
and spurious-free dynamic range (SFDR). The data can also 
be displayed in the time domain. To perform an ac test, apply 
a sinusoidal signal to the evaluation board at the SMA inputs, J6 
and J10. A low distortion, better than 100 dB signal is required 
to allow true evaluation of the device. One possibility is to filter the 
input signal from the ac source. A band-pass filter can be used, 
and its center frequency must match the test frequency of interest. 

Furthermore, if using a low frequency band-pass filter when 
the full-scale input range is more than a few volts peak-to-peak, 
use the on-board amplifiers to amplify the signal, thus preventing 
the filter from distorting the input signal. 

Figure 24 displays the histogram of the captured data that includes 
the following: 

 The spectrum information. 
 The fundamental frequency and amplitude in addition to 

the second to fifth harmonics. 
 The performance data (SNR, dynamic range, THD, 

SINAD, and noise performance). 
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Figure 24. FFT Tab (AD4003 Running in Turbo Mode) 
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SUMMARY TAB 
The Summary tab captures all the display information and 
provides them in one panel with a synopsis of the information, 
including key performance parameters, such as SNR and THD. 
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Figure 25. Summary Tab, Shows All Captured Windows 
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TROUBLESHOOTING 
SOFTWARE 
To troubleshoot the software, take the following steps: 

1. Always install the software before connecting the hardware to 
the PC. 

2. Always allow the install to fully complete (the software is a 
two-part installation, the ADC evaluation software and the 
SDP-H1 drivers). A restart is recommended after installation 
is finished. 

3. When the user first plugs in the SDP-H1 board via the USB 
cable provided, allow the Found New Hardware Wizard to 
run, which may take a little time. However, allow this to 
happen before starting the software. 

4. If the board does not appear to be functioning, ensure that 
the ADC evaluation board is connected to the SDP-H1 board 
and that the board is being recognized in the Device Manager, 
as shown in Figure 15. 

5. If connected to a slower USB port where the SDP-H1 cannot 
read as quickly as it needs to, a timeout error may result. In 
this case, it is advised not to read continuously, or alternatively, 
to lower the number of samples taken. 

HARDWARE 
To troubleshoot the hardware, take the following steps: 

1. If the software does not read back any data, do the following: 
a. Check that the power is applied within the power 

ranges described in the Power Supplies section. 
b. Using a voltmeter, measure the voltage present at each 

of the test points: +VS, −VS, 1P8V_VDD, VDD_1P8V, 
+3P3V, +5V, and REF1 and common-mode voltages 
(REF/2) at IN+ and IN− to ensure that they are correct. 
The SDP-H1 board LED1 must be lit. 

c. Launch the software and read the data. If nothing 
happens, exit the software. 

d. Power down the board and relaunch the software. 
e. If no data is read back, confirm that the ADC evaluation 

board is connected to the SDP-H1 board and that the 
board is being recognized in the Device Manager, as 
shown in Figure 15. 

2. When the user is working with the software in standalone/ 
offline mode (no hardware connected) and later chooses to 
connect hardware, close and relaunch the software. 
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EVALUATION BOARD SCHEMATICS AND ARTWORK 
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Figure 26. ADC Evaluation Board, Power Supplies 
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Figure 27. ADC Evaluation Board, Voltage Reference, Common-Mode and Reference Buffers  
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Figure 28. ADC Evaluation Board, ADC Drivers, and ADC 
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Figure 29. ADC Evaluation Board, SDP-H1 Connector and Glue Logic  
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Figure 30. ADC Evaluation Board Silkscreen, Top Layer  
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Figure 31. ADC Evaluation Board, Layer 1  
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Figure 32. ADC Evaluation Board, Layer 2  
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Figure 33. ADC Evaluation Board, Layer 3  
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Figure 34. ADC Evaluation Board, Layer 4 
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PRODUCTS ON THIS EVALUATION BOARD 
AD4000/AD4001/AD4002/AD4003/AD4020 EVALUATION BOARD BILL OF MATERIALS 

Table 6. Bill of Materials 
Name Part Description Manufacturer Part Number Stock Code 
U1 16-/18-bit, 2 MSPS or 20-bit, 1.8 MSPS 

precision SAR ADC in 10-lead MSOP 
Analog Devices See Table 7 See Table 7 

U2 Ultralow power, low distortion ADC 
driver, 4 nV/√Hz 

Analog Devices ADA4940-1 Do not place 

U3 High voltage, 1.2 MHz/600 kHz, 
800 mA, low quiescent current 
buck regulator 

Analog Devices ADP2370 ADP2370ACPZ-5.0-R7 

U4 Linear regulator, 3.3 V, ultralow 
noise, complementary metal–oxide 
semiconductor (CMOS) 

Analog Devices ADP7118 ADP7118AUJZ-3.3-R7 

U6 Ultralow noise, high accuracy 
voltage reference 

Analog Devices ADR4550 ADR4550BRZ 

U7 CMOS, switched capacitor voltage 
converter 

Analog Devices ADM660 ADM660ARZ 

U8 IC EEPROM, 2 kb, 400 kHz, 8-lead 
SOIC 

ST M24C02-WMN6TP Digi-Key 497-8552-1-ND 

U12, U14 (only for 
AD4001/AD4002/ 
AD4003/AD4020) 

Low noise, high speed amplifiers Analog Devices ADA4807-1 ADA4807-1ARJZ 

U12, U14 (only for 
AD4000) 

Low noise, high speed amplifiers Analog Devices ADA4805-1 ADA4805-1ARJZ 

U16, U18 Low noise, high speed amplifiers Analog Devices ADA4807-1 ADA4807-1ARJZ 
U17 Linear regulator, 3.3 V, ultralow 

noise, CMOS 
Analog Devices ADP7118 ADP7118AUJZ-3.3-R7 

U19 Linear regulator, 1.8 V, ultralow 
noise, CMOS 

Analog Devices ADP7118 ADP7118AUJZ-1.8-R7 

U20 Ultralow power step-down regulator Analog Devices ADP5300 ADP5300ACPZ-1-R7 
U21 –28 V, −200 mA, low noise, linear 

regulator 
Analog Devices ADP7182 ADP7182AUJ-2.5-R7 

U22 Micropower, high accuracy, 5 V 
voltage reference 

Analog Devices ADR3450 ADR3450ARJZ-R2 

C1, C2, C5, C9, C61 10 μF, 20 V tantalum capacitors AVX TAJB106K020RNJ FEC 197427 
C3, C4, C16, C17, C21, 

C26 
2.2 μF, X7R, 16 V, 0805 capacitors, 
MLCC 

Murata GRM21BR71C225KA12L FEC 1828829 

C6 4.7 μF, 16 V, X7R, 0805 ceramic 
capacitor 

Taiyo Yuden EMK212B7475KG-T FEC 1853520 

C7, C10, C12, C18, C40, 
C68, C73, C74, C75, 
C76, C77 

10 μF, 16 V, 0805 capacitors Murata GRM219R61C106KA73D FEC 1845747 

C8, C57, C64, C69, C71 1 μF, X7R, 50 V, 0805 capacitors Murata GRM21BR71H105KA12L FEC 1735541 
C14, C15 100 nF, X7R, 25 V, 0805 capacitors Murata LLL216R71E104MA01L FEC 1294646 
C24, C30, C37, C41, 

C42, C44, C45, C48, 
C54, C60, C66, C67, 
C70 

0.1 μF, X7R, 50 V ceramic capacitors Murata GRM188R71H104KA93D FEC 8820023 

C35, C52 180 pF, 50 V, 0603, C0G/NP0 
capacitors 

YAGEO 
(Phycomp) 

CC0603JRNPO9BN181 FEC 3019494 

C11, C13, C19, C20, 
C25, C29, C32, C36, 
C38, C39, C43, C46, 
C47, C49, C50, C51, 
C55, C63, C72 

SMD capacitors Not applicable Not applicable Do not place 
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Name Part Description Manufacturer Part Number Stock Code 
C56 10 μF, X5R, 25 V, 0805, MLCC 

capacitor 
Murata GRM219R61E106KA12D FEC 2426961 

C58, C65 2.2 μF, 50 V, 0805, X7R capacitors TDK C2012X7R1H225K125AC FEC 2346945 
C186 SMD capacitor EPCOS B37921C9104K60 Digi-Key 495-3265-1-ND 
L1 1000 Ω at 100 MHz, 1206, WE-CBF 

SMD, EMI suppression ferrite 
Wurth 742792141 Wurth 742792141 

L3 10 μH, inductor, shielded power, 
XAL40 series 

Coilcraft XAL4040-103ME XAL4040-103ME 

L4 2.2 μH, inductor, shielded power, 
XAL40 series 

Coilcraft XAL4020-222MEB Coilcraft XAL4020-222MEB 

LED1 LED, SMD green OSRAM LGQ971 Digi-Key 475-1409-1-ND 
R1 2.4 kΩ, 0.063 W, 1%, 0603 resistor Multicomp MC0063W060312K4 FEC 9330879 
R2 100 kΩ, 0.1 W, 1%, 0805 resistor Multicomp MC01W08051100K FEC 9332405 
R3, R11, R12, R13, R14, 

R20, R21, R23, R25, 
R36, R38, R40, R42, 
R44, R46, R48, R50, 
R51, R52, R53, R59, 
R66, R68, R69, R73, 
R74, R75, R77, R78, 
R79, R85, R86, R90, 
R91, R95, R96, R99, 
R100 

0 Ω, SMD resistors Multicomp MC 0.063W 0603 0R FEC 9331662 

R4, R5, R8, R9 1 kΩ, 0.063 W, 1%, 0603 resistors Multicomp MC0063W060311K FEC 9330380 
R7 88.7 kΩ, 1%, 0805 resistor Vishay Draloric CRCW080588K7FKEA FEC 2139026 
R10 1%, 0805 resistor Multicomp MC01W08050R FEC 9333681 
R17, R22, R32, R37 49.9 Ω, 0.1 W, 0.1%, 0805 resistors Panasonic RN73C2A49R9BTG FEC 1140694 
R24, R41 200 Ω, 0.1 W, 1%, 0805 resistors Multicomp MC01W08051200R FEC 9332758 
R27, R28, R34, R35 Thick film chip resistors Vishay Draloric CRCW0805590RFKEA FEC 1653021 
R45, R65, R67 10 kΩ, 0.1 W, 1%, 0805 resistors Multicomp MC01W0805110K FEC 9332391 
R93 20 kΩ, 0.063 W, 1%, 0603 resistor Multicomp MC0063W0603120K FEC 9330771 
R6, R15, R16, R18, R19, 

R26, R29, R30, R31, 
R33, R39, R43, R49, 
R54, R55, R56, R57, 
R58, R60, R70, R71, 
R72, R76, R80, R84, 
R87, R88, R89, R92, 
R94, R97, R98, R101 

SMD resistors, 0603 Not applicable Not applicable Do not place 

J2, J3 3-pin terminal blocks (5 mm pitch) CamdenBoss CTB5000/3 FEC 151790 
J5 160-pin, 10 mm male VITA 57 

connector 
Samtec ASP-134604-01 Samtec ASP-134604-01 

J6, J10 Connector jack end launch PC gold 
SMAs 

Emerson 142-0701-851 Digikey J658-ND 

J8 7-way SSW 2.54 mm vertical socket Samtec SSW-107-01-T-S FEC 1803478 
J9 7-way sip 2.54 mm TH header Samtec TLW-107-05-G-S FEC 1668499 

Table 7. Evaluation Board Models 
Product Ordering Model Sample Rate (MSPS) Resolution (Bits) Package Used on Evaluation Board 
AD4000BRMZ EVAL-AD4000FMCZ 2 16 10-lead MSOP 
AD4001BRMZ EVAL-AD4001FMCZ 2 16 10-lead MSOP 
AD4002BRMZ EVAL-AD4002FMCZ 2 18 10-lead MSOP 
AD4003BRMZ EVAL-AD4003FMCZ 2 18 10-lead MSOP 
AD4020BRMZ EVAL-AD4020FMCZ 1.8 20 10-lead MSOP 
 

 

https://www.analog.com/AD4000?doc=UG-1042.pdf
https://www.analog.com/EVAL-AD400x-FMCZ?doc=UG-1042.pdf
https://www.analog.com/AD4001?doc=UG-1042.pdf
https://www.analog.com/AD4002?doc=UG-1042.pdf
https://www.analog.com/AD4003?doc=UG-1042.pdf
https://www.analog.com/AD4020?doc=UG-1042.pdf
https://www.analog.com/EVAL-AD400x-FMCZ?doc=UG-1042.pdf
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RELATED LINKS 
Resource Description 
ADA4805-1 0.2 μV/°C Offset Drift, 105 MHz Low Power, Low Noise, Rail-to-Rail Amplifier 
ADA4807-1 Low Power, Low Noise and Distortion, Rail-to-Rail Output Amplifier  
ADA4940-1 Ultralow Power, Low Distortion, Fully Differential ADC Driver 
ADR3450 Micropower, High Accuracy 5.0 V Voltage Reference 
ADR4550 Ultralow Noise, High Accuracy 5.0 V Voltage Reference 
ADP7118 20 V, 200 mA, Low Noise, CMOS LDO Linear Regulator  
ADP7182 −28 V, 200 mA, Low Noise, Linear Regulator 
ADM660 CMOS Switched Capacitor Voltage Converter 
ADP2370 High Voltage, 1.2 MHz/600 kHz, 800 mA, Low Quiescent Current Buck Regulator 
ADP5300 50 mA/500 mA, High Efficiency, Ultralow Power Step-Down Regulator 
EVAL-SDP-CH1Z High-Speed Controller Board for System Demonstration Platform (SDP-H1) 
AN-931 Understanding PulSAR® ADC Support Circuitry 

 

 

 

ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided 
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional 
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term 
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including 
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may 
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to 
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any 
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written 
notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, 
RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF 
INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S 
POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES 
SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will 
comply with all applicable United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the 
Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and 
Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is 
expressly disclaimed. 

©2016–2018 Analog Devices, Inc. All rights reserved. Trademarks and  
 registered trademarks are the property of their respective owners. 
  UG14981-0-12/18(G) 

https://www.analog.com/ADA4805-1?doc=UG-1042.pdf
https://www.analog.com/ADA4805-1?doc=UG-1042.pdf
https://www.analog.com/ada4807-1?doc=UG-1042.pdf
https://www.analog.com/ada4807-1?doc=UG-1042.pdf
https://www.analog.com/ADA4940-1?doc=UG-1042.pdf
https://www.analog.com/ADR3450?doc=UG-1042.pdf
https://www.analog.com/ADR4550?doc=UG-1042.pdf
https://www.analog.com/ADR4550?doc=UG-1042.pdf
https://www.analog.com/ADP7118?doc=UG-1042.pdf
https://www.analog.com/adp7182?doc=UG-1042.pdf
https://www.analog.com/adm660?doc=UG-1042.pdf
https://www.analog.com/ADP2370?doc=UG-1042.pdf
https://www.analog.com/ADP5300?doc=UG-1042.pdf
https://www.analog.com/SDP-H1?doc=UG-1042.pdf
https://www.analog.com/SDP-H1?doc=UG-1042.pdf
https://www.analog.com/SDP-H1?doc=UG-1042.pdf
https://www.analog.com/AN-931?doc=UG-1042.pdf
https://www.analog.com
https://www.analog.com/EVAL-AD400x-FMCZ?doc=UG-1042.pdf

	Features
	Evaluation Board Kit Contents
	Equipment Needed
	General Description
	Table of Contents
	Revision History
	Evaluation Board Photograph
	Evaluation Board Hardware
	Setting Up the Evaluation Board
	Power Supplies
	Reference, Reference Buffer, and Common-Mode Buffer
	SDP-H1 Controller Board
	Solder Links
	Analog Inputs

	Evaluation Board Software
	Installing the Software
	Installation Steps
	Board Operation/Connection Sequence
	Running the Software with the Hardware Connected

	Software Operation
	Description of the User Panel
	Waveform Capture
	AC Testing—Histogram
	DC Testing—Histogram
	AC Testing—FFT Capture
	Summary Tab

	Troubleshooting
	Software
	Hardware

	Evaluation Board Schematics and Artwork
	Products on This Evaluation Board
	AD4000/AD4001/AD4002/AD4003/AD4020 Evaluation Board Bill of Materials
	Related Links



		[image: image40.emf]

		Easy to Use AD4000 Series 16-/18-/20-Bit Precision SAR ADCs User Guide


UG-1042



		One Technology Way • P.O. Box 9106 • Norwood, MA 02062-9106, U.S.A. • Tel: 781.329.4700 • Fax: 781.461.3113 • www.analog.com



		Evaluation Board for the AD4000 Series 16-/18-/20-Bit Precision SAR ADCs





		UG-1042

		Easy to Use AD4000 Series 16-/18-/20-Bit Precision SAR ADCs User Guide





		Easy to Use AD4000 Series 16-/18-/20-Bit Precision SAR ADCs User Guide

		UG-1042







Features


Fully featured evaluation board for 10-lead precision ADCs


Versatile analog signal conditioning circuitry


On-board reference, reference buffers, and ADC drivers


PC software for control and data analysis of time and frequency domain


System demonstration platform-compatible (EVAL-SDP-CH1Z)

Evaluation Board Kit Contents


AD4000/AD4001/AD4002/AD4003/AD4020 evaluation board 
(see Table 7)


12 V wall adapter power supply


Equipment Needed


SDP-H1 board (EVAL-SDP-CH1Z

)


Precision signal source


Cable (SMA input to evaluation board)


Standard USB A to mini-B USB cable


Band-pass filter suitable for 16-bit, 18-bit, and 20-bit testing (value based on signal frequency)

AD40xx evaluation software

General Description


The AD4000/AD4001/AD4002/AD4003/AD4020 family evaluation board covers the ease of use, 16-/18-/20-bit, precision successive approximation register (SAR) analog-to-digital converters (ADCs). The AD4000/AD4001/AD4002/
AD4003/AD4020 are low power, 16-bit/18-bit/20-bit, precision SAR ADCs that offer very high performance with throughputs up to 2 MSPS (1.8 MSPS for the AD4020). The evaluation board is designed to demonstrate the performance of the AD4000/
AD4001/AD4002/AD4003/AD4020 family of ADCs and to provide an easy to understand interface for a variety of system applications. A full description of these products is available in their respective data sheets, which must be consulted when using this evaluation board.


The EVAL-AD4000FMCZ/EVAL-AD4001FMCZ/EVAL-AD4002FMCZ/EVAL-AD4003FMCZ/EVAL-AD4020FMCZ evaluation boards (see Figure 1) are ideal for use with the Analog Devices, Inc., high speed system demonstration platform (EVAL-SDP-CH1Z). These evaluation boards interface to the SDP-H1 board via a 120-pin connector. SMA connectors, JP2 and JP3, are provided for the low noise analog signal source.


On-board components include a high precision buffered band gap 5.0 V reference (the ADR4550), a reference buffer (the ADA4807-1ADA4807-1

), a common-mode buffer (the ), a signal conditioning circuit with two op amps (the ADA4807-1

), and a power supply to derive the necessary voltage levels to supply all voltage needs.


The EVAL-AD4000FMCZ, EVAL-AD4001FMCZ, EVAL-AD4002FMCZ, and EVAL-AD4003FMCZ are populated with the AD4000, AD4001, AD4002, and AD4003, respectively. However, these boards can be used to evaluate the performance of the AD4004, AD4005, AD4006, AD4007, AD4008, AD4010, and AD4011 by limiting the sample rate in the evaluation software to the maximum sample rate of the specific ADC. For example, the AD4000 on the EVAL-AD4000FMCZ can be used to evaluate the performance of the AD4004 if the sample rate is limited to 1 MSPS. See the data sheet of each product for its corresponding evaluation board.
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Figure 1.


Evaluation Board Hardware
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Figure 2. Simplified Evaluation Board Block Diagram

Setting Up the Evaluation Board


Figure 2 shows the simplified evaluation board block diagram. Figure 26 shows the evaluation board schematic. The board consists of the ADC, U1, with a reference, U6 (ADR4550), and ADC drivers, U12 and U14, the AD4001ADA4807-1

 for the /
AD4002/AD4003/AD4020 and the ADA4805-1 for the AD4000 (see Table 6). The user also has an option to populate U2 with a low power, fully differential ADC driver such as the ADA4940-1 when evaluating the AD4001/AD4003/AD4020. The evaluation board is a flexible design that enables the user to select components in addition to operating from an adjustable bench top power supply.

Power Supplies


The system demonstration platform (SDP-H1) board supplies 12 V to power the necessary rails for the AD4000/AD4001/
AD4002/AD4003/AD4020 evaluation board.


Table 1. Power Supplies Provided on the Board

		Power Supply (V)

		Function 

		Components Used



		5, 7 (default)1

		Positive rail

		ADP7118



		−5, −2.5 (default)1

		Negative rail

		ADP2370, ADM660, ADP7182



		1.8

		ADC power

		ADP7118, ADP5300



		3.3

		VDRIVE (digital power)

		ADP7118





1 See Table 2.


The 7 V amplifier positive rail (+VS) is generated from U17 (the ADP7118). The −2.5 V negative amplifier rail (−VS) is generated by a combination of U3 (the ADP2370), U7 (the ADM660), and U21 (the ADP7182).


Each supply is decoupled where it enters the board and again at each device. A single ground plane is used on this board to minimize the effect of high frequency noise interference. 


In addition, there is also the ability to power the board from a bench top power supply. The screw terminals, J2 and J3, are provided for this function. When bench power is used, the on-board power supplies are no longer required. The solder links also must be changed: SL1 = SL2 = SL5 = SL6 = SL7 = SL8 = SL9 = B.

Reference, Reference Buffer, and Common-Mode Buffer


An external 5 V reference (U6, ADR4550

) is used by default to supply the ADCs directly. However, the user can also use one of the 2.5 V, 3.3 V, and 4.096 V references by changing the reference device on the board (U6, ADR4525/ADR4533/ADR4540). There is also an option to use a lower power reference (U22, ADR3450


). Note that the ADA4807-1ADR3450



 cannot accept input voltages beyond 5.5 V. The  is used as a reference buffer (U16) and common-mode buffer (U18) by default. However, it can also be replaced by the AD8031 if needed without compromising the performance.

SDP-H1 Controller Board


The evaluation board uses a serial port interface (SPI) and is connected to the high speed controller board for the system demonstration platform (SDP-H1) controller board. The SDP-H1 board requires power from a 12 V wall adapter. The SDP-H1 has a Xilinx® Spartan 6 and an ADSP-BF527 processor with connectivity to the PC through a USB 2.0 high speed port. The controller boards allow the configuration and capture of data on daughter boards from the PC via USB. 


The SDP-H1 has an FMC low pin count (LPC) connector with full differential low voltage differential signaling (LVDS) and singled-ended low voltage complementary metal-oxide semiconductor (LVCMOS) support. It also has the 120-pin connector, found on the SDP-B, which exposes the Blackfin® processor peripherals. This connector provides a configurable serial, parallel I2C and SPI, and general purpose input/output (GPIO) communications lines to the attached daughter board.


Solder Links


The three solder link options on the evaluation board are configured depending on which generic of the ADC is on the specific evaluation board, as described in Table 3.


Table 2. Jumper Detail with Factory Default Setting


		Link

		Default

		Function

		Comment



		SL1

		A

		+VS

		Change to B if using bench supplies



		SL2

		A

		−VS

		Change to B if using bench supplies



		SL5

		A

		+VS

		Change to B if using bench supplies



		SL6

		A

		−VS

		Change to B if using bench supplies



		SL7

		A

		VDD for ADC

		Change to B if using bench supplies



		SL8

		A

		−VS

		Change to B if using bench supplies



		SL9

		A

		+VS

		Change to B if using bench supplies



		LK2

		A

		VREF

		Change to B if using the ADR3450







		LK5

		B

		SDI

		Change to A if using V_DRIVE



		JP1

		B

		FSEL (U3)

		Change to A if using ground



		JP2

		B

		ADC drivers

		Change to A if using the ADA4940‑1

 fully differential ADC



		JP3

		B

		ADC drivers

		Change to A if using the ADA4940‑1

 fully differential ADC



		JP4

		B

		ADC drivers

		Change to A if using the ADA4940‑1

 fully differential ADC



		JP5

		B

		ADC drivers

		Change to A if using the ADA4940‑1

 fully differential ADC



		JP7

		B

		V_DRIVE

		Change to A if using external 3.3 V for V_DRIVE



		JP8

		B

		STOP (U20)

		Change to A if using CNV_FMC from SDP-H1 connector





Table 3. Jumpers Specific to 10-Lead Precision ADCs


		Link

		Default

		Configuration

		Generic



		SL4

		A

		Differential input

		AD4001, AD4003, AD4020



		SL4

		B

		Single-ended or pseudo differential

		AD4000, AD4002





The evaluation board supports any amplifier mezzanine card (AMC). Insert this add on card on the 7-pin headers. Figure 3 shows the AMC mounted on the evaluation board. The AMC ADC driver settings are required to use this option, as shown on Table 4.
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Figure 3. AMC Installed on the EVAL-AD4000FMCZ

Table 4. Amplifier Mezzanine Card ADC Driver


		Default

		Function

		Comment



		0 Ω (R20, R21), R19 Do Not Insert (DNI)

		AMC ADC driver analog positive input (VIN+)

		Removed R20 and R21



		0 Ω (R20, R21), R39 DNI

		AMC ADC driver analog negative input (VIN−)

		Removed R36 and R40





Analog Inputs


The analog inputs to the evaluation board are SMA connectors, J6 and J10. These inputs are buffered with dedicated amplifier circuitry (U12 and U14), as shown in Figure 28. The circuit allows different configurations, input range scaling, filtering, addition of a dc component, and use of different op amp and supplies. The analog input amplifiers are set as unity-gain buffers at the factory.

The default configuration sets both U12 and U14 at midscale, generated from a buffered reference voltage divider (VCM).

The evaluation board is factory configured to provide either a single-ended path or a fully differential path.


For dynamic performance, a fast Fourier transform (FFT) test can be performed by applying a very low distortion ac source.


For low frequency testing, the audio precision source (such as the SYS-2700 series) can be used directly because the outputs on these are isolated. Set the outputs for balanced and floating ground. Different precision sources can be used with additional filtering. 


Because the evaluation board uses the amplifiers in unity-gain, the noninverting input has a common-mode input with a 590 Ω resistor divider, and it must be taken into account when directly connecting a source.


Evaluation Board Software


Installing the Software


The evaluation board software can be downloaded from the EVAL-AD40XX-FMCZ product page.

Install the software before connecting the SDP-H1 board to the USB port of the PC to ensure that the SDP-H1 board is recognized when it connects to the PC.

1. Start the Windows® operating system and download the software from the relevant product page on the Analog Devices website.


2. Unzip the downloaded file. Run the setup.exe file.


3. After installation is completed, power up the evaluation board as described in the Power Supplies section.

4. Plug the evaluation board into the SDP-H1 board and the SDP-H1 board into the PC using a USB cable.


5. When the software detects the evaluation board, proceed through any dialog boxes that appear to finalize the installation.


The default location for the software is the following: C:\Program Files\Analog Devices\AD40XX Evaluation Software\EVAL-AD40XX.

This location contains the executable software and example files.

Installation Steps


Proceed through the installation, allowing the software and drivers to be placed in the appropriate locations. Connect the SDP-H1 board to the PC only after the software and drivers are installed.

There are two parts to the software installation. First, install the software related to the evaluation board, as follows:

1. Launch the evaluation board software installation by clicking the setup.exe file. The software installation window opens, as shown in Figure 4.
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Figure 4. AD40XX Evaluation Software Install Window

2. Choose the folder location for installation and click Next. The default folder is shown in Figure 5.
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Figure 5. Destination Directory Window

3. Accept the National Instruments software license agreement and click Next (see Figure 6).

[image: image6.emf]14981-004




Figure 6. License Agreement Window

4. Click Next again to install the software.
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Figure 7. Start Installation Window

5. A pop-up window opens and displays a bar showing the installation progress, as shown in Figure 8.
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Figure 8. Overall Progress


6. Click Next to complete the installation and to launch the SDP-H1 driver installation as shown in Figure 10.
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Figure 9. Installation Complete Window

The second part of the software installation is the drivers related to the SDP-H1 board. These drivers must be installed for the evaluation board to function correctly.
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Figure 10. Beginning of SDP-H1Driver Installation


7. The ADI SDP Drivers 2.2.95.68 Setup Wizard opens. Click Next to install the SDP-H1 drivers.
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Figure 11. ADI SDP Drivers 2.2.95.68 Setup Wizard Window

8. Choose the installation location and click Install; the default folder is shown in Figure 12.
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Figure 12. Choose Install Location Window

9. The installation begins, and a progress bar is displayed.
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Figure 13. Installing Window

10. Click Close to complete the installation.
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Figure 14. Installation Complete Window

When you first plug in the SDP-H1 board via the USB cable provided, allow the Found New Hardware Wizard to run. You can check that the drivers and the board are connected correctly by looking at the Device Manager of the PC. Analog Devices System Development Platform (32MB) appears under ADI Development Tools.
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Figure 15. Device Manager


Board Operation/Connection Sequence


The following is the board operation/connection sequence:


1. Connect theSDP-H1 controller board to the evaluation board with the J5 connector (screw into place as required). The software is configured to find the evaluation board on either connector of the SDP-H1 board.

2. Power the board with the appropriate supply, as described in the Power Supplies section.

3. Connect the board to the PC with the USB cable.


4. Launch the software. Click Start > All Programs > Analog Devices\AD40XX Evaluation Software\EVAL-AD40XX. 


5. Apply the signal source and capture the data.


Running the Software with the Hardware Connected


To run the program, take the following steps:


1. Click Start > All Programs > Analog Devices > AD40XX Evaluation Software > EVAL-AD40XX. To uninstall the program, click Start > Control Panel > Programs and Features > Analog Devices AD40XX Evaluation Software.

2. The software automatically seeks to find the hardware connected; therefore, when no hardware is connected, it displays a connectivity error (see Figure 16) when the software is launched. Connect the evaluation board to the SDP-H1 and connect the SDP-H1 to the USB port of the PC, wait a few seconds, click Rescan, and then follow the instructions (see Figure 16).
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Figure 16. SDP-H1 Board Not Connected to the USB Port Error 


3. If Cancel is clicked, a message appears as shown in Figure 17.
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Figure 17. SDP-H1 Board Not Connected to the USB Port Error 


4. The software then connects to the board and displays the message shown in Figure 18.
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Figure 18. Software Connects to SDP-H1 Board


5. When the board is correctly detected, the software panel opens.

Software Operation


When the software launches, the panel opens and the software searches for the hardware connected to the PC. The software detects the generic attached to the PC, and the software panel then launches as shown in Figure 19.

Description of the User Panel


The following is the description of the user panel.


The File menu (Label 1 in Figure 19) has the choice of the following options:


· Save Captured Data allows the user to save the current captured data for later analysis; the file format is .csv. The user is prompted to choose or enter the path of the file in the Save As dialog box (see Figure 20). Save to an appropriate folder location.

· Load Captured Data opens the Load File dialog box, where the user is prompted to load previously captured data in .csv format for analysis.


· Take Screenshot allows the user to save the current screen capture as a .jpg.


· Print Screenshot allows the user to save the current screen capture as a .pdf.

· Exit stops running the application software.
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Figure 19. Setup Screen
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Figure 20. Save As Dialog Box


The Edit menu (Label 1 in Figure 19) provides the option to reset the software to its initial state (Reinitialize to Default Values).


The Help menu (Label 1 in Figure 19) offers information about the following:

· Analog Devices Website

· User Guide


· Context Help

· About

When hardware is connected to the USB port, the software automatically detects which generic is connected and displays it (Label 2 in Figure 19).


The Throughput box is Label 3 in Figure 19. The default value is the maximum sample rate that the active device can support without turbo mode enabled. The maximum supported throughput of 2 MSPS (or 1.8 MSPS for the AD4020) can only be achieved by enabling turbo mode (Label 11 in Figure 19). If the user enters a value larger than the ability of the existing device, the software reverts to the maximum throughput. The user can adjust the throughput to a minimum of 10 kSPS.


The Voltage Reference dropdown menu is Label 4 in Figure 19. By default, this reference is 5 V (ADR4550

 on-board reference). The minimum/maximum voltage calculations are based on this reference voltage. If the user changes the reference voltage, this input must be changed accordingly.

Click Single Capture to perform a single capture and click Continuous Capture to perform a continuous stream capture from the ADC. (Both are noted with Label 5 in Figure 19.)


Select Samples (Label 6 in Figure 19) to analyze data using the particular number of samples. The maximum number of samples the software can support is 524,288.

Four capture tabs (Label 7 in Figure 19) display the data in different formats, as follows: 


· Waveform


· Histogram


· FFT


· Summary

Click Enable Status Bits (Label 8 in Figure 19) to enable the content of status header. Status bits can be clocked out at the end of the conversion data using six extra clocks when it is enabled.


Click Span Compression (Label 9 in Figure 19) to enable the ADC span compression feature. In single-supply applications, the use of span compression increases the headroom and footroom available to the ADC driver by reducing the input range by 10% from the top and bottom of the range while still accessing all available ADC codes.


Click High-Z Mode (Label 10 in Figure 19) to enable the internal high-Z mode. Enabling this mode allows the low input current for the ADC and improves total harmonic distortion (THD) performance using low power/bandwidth precision ADC drivers for slow/dc type signals.


Click Turbo Mode (Label 11 in Figure 19) to enable turbo mode and run the ADC at the full throughput of 2 MSPS. 


Click Read Register (Label 12 in Figure 19) to check if any of the ease of use features are enabled, including span compression, high-Z mode, turbo mode, an overvoltage condition (which is a sticky bit), and the status bits. 


Clicking Enable Status Bits enables the six status bits, and the content of the six bits is updated and displayed in the Status Header section (Label 13 in Figure 19) after clicking single or continuous capture. Note that the overvoltage clamp flag status bit updates on a per conversion basis.


When the Busy indicator (Label 14 in Figure 19) is lit, the user must wait until the software completes the data analysis.


This software allows the user to select the Oversampling Ratio (Label 15 in Figure 19) up to 256 from the dropdown menu located in the Configure tab. The oversampling capability is implemented in the evaluation software by averaging the ADC output samples, that is, by summing the number of ADC samples and dividing it by the oversampling ratio to obtain the increased dynamic range.

To exit the software, click File > Exit.


Within any of the chart panels, the tools shown in Table 5 allow user control of the different chart displays.


Table 5. Graphical User Interface (GUI) Tools


		Symbol

		Description
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		This tool controls the cursor, if present.
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		This tool zooms in and out.
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		This tool is used for panning.





The evaluation software allows the user to export the raw data or image. Right clicking any of the four capture tabs (Waveform, Histogram, FFT, and Summary) open the menu as shown in Figure 21, and the user can either export the raw data in Excel format or save an image in .bmp, .eps, or .emf format.
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Figure 21. Export Raw Data or Image

Waveform Capture


Figure 22 illustrates the waveform capture. The input signal is a 1 kHz sine wave. The waveform analysis reports the amplitudes recorded from the captured signal in addition to the frequency of the signal tone. 
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Figure 22. Waveform Tab

AC Testing—Histogram


The ac testing histogram tests the ADC for the code distribution for the ac input, computes the mean and minimum/maximum amplitude and LSB size of the converter. Raw data is captured and passed to the PC for statistical computations. To perform a histogram test, click the Histogram tab and click Single Capture or Continuous Capture. Note that an ac histogram needs a quality signal source applied to the J6 and J10 input connectors. Figure 23 shows the histogram for a 1 kHz sine wave applied to the ADC input and illustrates the different measured values for the data captured.


DC Testing—Histogram


More commonly, the histogram is used for dc testing where the user tests the ADC for the code distribution for dc input, computes the mean and standard deviation, or transition noise, of the converter, and displays the results. Raw data is captured and passed to the PC for statistical computations. To perform a histogram test, click the Histogram tab and click Continuous Capture. Note that a histogram test can be performed without an external source using a VREF/2 (590 Ω resistor divider) at the ADC input. To test other dc values, apply a source to the J6 and J10 input connectors. It may be required to filter the signal to make the dc source noise compatible with that of the ADC.
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Figure 23. Histogram Tab, Histogram Captured for Sine Wave


AC Testing—FFT Capture


The traditional ac characteristics of the converter can be displayed on the FFT tab. As in the histogram test, raw data is captured and passed to the PC where the FFT is performed, displaying signal-to-noise ratio (SNR), signal-to-noise-and-distortion ratio (SINAD), total harmonic distortion (THD), and spurious-free dynamic range (SFDR). The data can also be displayed in the time domain. To perform an ac test, apply a sinusoidal signal to the evaluation board at the SMA inputs, J6 and J10. A low distortion, better than 100 dB signal is required to allow true evaluation of the device. One possibility is to filter the input signal from the ac source. A band-pass filter can be used, and its center frequency must match the test frequency of interest. Furthermore, if using a low frequency band-pass filter when the full-scale input range is more than a few volts peak-to-peak, use the on-board amplifiers to amplify the signal, thus preventing the filter from distorting the input signal.

Figure 24 displays the histogram of the captured data that includes the following:


· The spectrum information.

· The fundamental frequency and amplitude in addition to the second to fifth harmonics.

· The performance data (SNR, dynamic range, THD, SINAD, and noise performance).
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Figure 24. FFT Tab (AD4003 Running in Turbo Mode)


Summary Tab


The Summary tab captures all the display information and provides them in one panel with a synopsis of the information, including key performance parameters, such as SNR and THD.
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Figure 25. Summary Tab, Shows All Captured Windows


Troubleshooting


Software


To troubleshoot the software, take the following steps:


1. Always install the software before connecting the hardware to the PC.

2. Always allow the install to fully complete (the software is a two-part installation, the ADC evaluation software and the SDP-H1 drivers). A restart is recommended after installation is finished.

3. When the user first plugs in the SDP-H1 board via the USB cable provided, allow the Found New Hardware Wizard to run, which may take a little time. However, allow this to happen before starting the software.

4. If the board does not appear to be functioning, ensure that the ADC evaluation board is connected to the SDP-H1 board and that the board is being recognized in the Device Manager, as shown in Figure 15.


5. If connected to a slower USB port where the SDP-H1 cannot read as quickly as it needs to, a timeout error may result. In this case, it is advised not to read continuously, or alternatively, to lower the number of samples taken.

Hardware


To troubleshoot the hardware, take the following steps:


1. If the software does not read back any data, do the following:


a. Check that the power is applied within the power ranges described in the Power Supplies section.

b. Using a voltmeter, measure the voltage present at each of the test points: +VS, −VS, 1P8V_VDD, VDD_1P8V, +3P3V, +5V, and REF1 and common-mode voltages (REF/2) at IN+ and IN− to ensure that they are correct. The SDP-H1 board LED1 must be lit.


c. Launch the software and read the data. If nothing happens, exit the software.

d. Power down the board and relaunch the software.

e. If no data is read back, confirm that the ADC evaluation board is connected to the SDP-H1 board and that the board is being recognized in the Device Manager, as shown in Figure 15.


2. When the user is working with the software in standalone/
offline mode (no hardware connected) and later chooses to connect hardware, close and relaunch the software.

Evaluation Board Schematics and Artwork
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Figure 26. ADC Evaluation Board, Power Supplies
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Figure 27. ADC Evaluation Board, Voltage Reference, Common-Mode and Reference Buffers 
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Figure 28. ADC Evaluation Board, ADC Drivers, and ADC
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Figure 29. ADC Evaluation Board, SDP-H1 Connector and Glue Logic 


[image: image33.emf]14981-027




Figure 30. ADC Evaluation Board Silkscreen, Top Layer 
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Figure 31. ADC Evaluation Board, Layer 1 
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Figure 32. ADC Evaluation Board, Layer 2 
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Figure 33. ADC Evaluation Board, Layer 3 
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Figure 34. ADC Evaluation Board, Layer 4


Products on This Evaluation Board


AD4000/AD4001/AD4002/AD4003/AD4020 Evaluation Board Bill of Materials


Table 6. Bill of Materials


		Name

		Part Description

		Manufacturer

		Part Number

		Stock Code



		U1

		16-/18-bit, 2 MSPS or 20-bit, 1.8 MSPS precision SAR ADC in 10‑lead MSOP

		Analog Devices

		See Table 7

		See Table 7



		U2

		Ultralow power, low distortion ADC driver, 4 nV/√Hz

		Analog Devices

		ADA4940-1



		Do not place



		U3

		High voltage, 1.2 MHz/600 kHz, 800 mA, low quiescent current buck regulator

		Analog Devices

		ADP2370

		ADP2370ACPZ-5.0-R7



		U4

		Linear regulator, 3.3 V, ultralow noise, complementary metal–oxide semiconductor (CMOS)

		Analog Devices

		ADP7118

		ADP7118AUJZ-3.3-R7



		U6

		Ultralow noise, high accuracy voltage reference

		Analog Devices

		ADR4550



		ADR4550BRZ



		U7

		CMOS, switched capacitor voltage converter

		Analog Devices

		ADM660

		ADM660ARZ



		U8

		IC EEPROM, 2 kb, 400 kHz, 8-lead SOIC

		ST

		M24C02-WMN6TP

		Digi-Key 497-8552-1-ND



		U12, U14 (only for AD4001/AD4002/
AD4003/AD4020)

		Low noise, high speed amplifiers

		Analog Devices

		ADA4807-1



		ADA4807-1ARJZ



		U12, U14 (only for AD4000)

		Low noise, high speed amplifiers

		Analog Devices

		ADA4805-1



		ADA4805-1ARJZ



		U16, U18

		Low noise, high speed amplifiers

		Analog Devices

		ADA4807-1



		ADA4807-1ARJZ



		U17

		Linear regulator, 3.3 V, ultralow noise, CMOS

		Analog Devices

		ADP7118

		ADP7118AUJZ-3.3-R7



		U19

		Linear regulator, 1.8 V, ultralow noise, CMOS

		Analog Devices

		ADP7118

		ADP7118AUJZ-1.8-R7



		U20

		Ultralow power step-down regulator

		Analog Devices

		ADP5300

		ADP5300ACPZ-1-R7



		U21

		–28 V, −200 mA, low noise, linear regulator

		Analog Devices

		ADP7182

		ADP7182AUJ-2.5-R7



		U22

		Micropower, high accuracy, 5 V voltage reference

		Analog Devices

		ADR3450




		ADR3450ARJZ-R2



		C1, C2, C5, C9, C61

		10 µF, 20 V tantalum capacitors

		AVX

		TAJB106K020RNJ

		FEC 197427



		C3, C4, C16, C17, C21, C26

		2.2 µF, X7R, 16 V, 0805 capacitors, MLCC

		Murata

		GRM21BR71C225KA12L

		FEC 1828829



		C6

		4.7 µF, 16 V, X7R, 0805 ceramic capacitor

		Taiyo Yuden

		EMK212B7475KG-T

		FEC 1853520



		C7, C10, C12, C18, C40, C68, C73, C74, C75, C76, C77

		10 µF, 16 V, 0805 capacitors

		Murata

		GRM219R61C106KA73D

		FEC 1845747



		C8, C57, C64, C69, C71

		1 µF, X7R, 50 V, 0805 capacitors

		Murata

		GRM21BR71H105KA12L

		FEC 1735541



		C14, C15

		100 nF, X7R, 25 V, 0805 capacitors

		Murata

		LLL216R71E104MA01L

		FEC 1294646



		C24, C30, C37, C41, C42, C44, C45, C48, C54, C60, C66, C67, C70

		0.1 µF, X7R, 50 V ceramic capacitors

		Murata

		GRM188R71H104KA93D

		FEC 8820023



		C35, C52

		180 pF, 50 V, 0603, C0G/NP0 capacitors

		YAGEO (Phycomp)

		CC0603JRNPO9BN181

		FEC 3019494



		C11, C13, C19, C20, C25, C29, C32, C36, C38, C39, C43, C46, C47, C49, C50, C51, C55, C63, C72

		SMD capacitors

		Not applicable

		Not applicable

		Do not place



		C56

		10 µF, X5R, 25 V, 0805, MLCC capacitor

		Murata

		GRM219R61E106KA12D

		FEC 2426961



		C58, C65

		2.2 µF, 50 V, 0805, X7R capacitors

		TDK

		C2012X7R1H225K125AC

		FEC 2346945



		C186

		SMD capacitor

		EPCOS

		B37921C9104K60

		Digi-Key 495-3265-1-ND



		L1

		1000 Ω at 100 MHz, 1206, WE-CBF SMD, EMI suppression ferrite

		Wurth

		742792141

		Wurth 742792141



		L3

		10 µH, inductor, shielded power, XAL40 series

		Coilcraft

		XAL4040-103ME

		XAL4040-103ME



		L4

		2.2 µH, inductor, shielded power, XAL40 series

		Coilcraft

		XAL4020-222MEB

		Coilcraft XAL4020-222MEB



		LED1

		LED, SMD green

		OSRAM

		LGQ971

		Digi-Key 475-1409-1-ND



		R1

		2.4 kΩ, 0.063 W, 1%, 0603 resistor

		Multicomp

		MC0063W060312K4

		FEC 9330879



		R2

		100 kΩ, 0.1 W, 1%, 0805 resistor

		Multicomp

		MC01W08051100K

		FEC 9332405



		R3, R11, R12, R13, R14, R20, R21, R23, R25, R36, R38, R40, R42, R44, R46, R48, R50, R51, R52, R53, R59, R66, R68, R69, R73, R74, R75, R77, R78, R79, R85, R86, R90, R91, R95, R96, R99, R100

		0 Ω, SMD resistors

		Multicomp

		MC 0.063W 0603 0R

		FEC 9331662



		R4, R5, R8, R9

		1 kΩ, 0.063 W, 1%, 0603 resistors

		Multicomp

		MC0063W060311K

		FEC 9330380



		R7

		88.7 kΩ, 1%, 0805 resistor

		Vishay Draloric

		CRCW080588K7FKEA

		FEC 2139026



		R10

		1%, 0805 resistor

		Multicomp

		MC01W08050R

		FEC 9333681



		R17, R22, R32, R37

		49.9 Ω, 0.1 W, 0.1%, 0805 resistors

		Panasonic

		RN73C2A49R9BTG

		FEC 1140694



		R24, R41

		200 Ω, 0.1 W, 1%, 0805 resistors

		Multicomp

		MC01W08051200R

		FEC 9332758



		R27, R28, R34, R35

		Thick film chip resistors

		Vishay Draloric

		CRCW0805590RFKEA

		FEC 1653021



		R45, R65, R67

		10 kΩ, 0.1 W, 1%, 0805 resistors

		Multicomp

		MC01W0805110K

		FEC 9332391



		R93

		20 kΩ, 0.063 W, 1%, 0603 resistor

		Multicomp

		MC0063W0603120K

		FEC 9330771



		R6, R15, R16, R18, R19, R26, R29, R30, R31, R33, R39, R43, R49, R54, R55, R56, R57, R58, R60, R70, R71, R72, R76, R80, R84, R87, R88, R89, R92, R94, R97, R98, R101

		SMD resistors, 0603

		Not applicable

		Not applicable

		Do not place



		J2, J3

		3-pin terminal blocks (5 mm pitch)

		CamdenBoss

		CTB5000/3

		FEC 151790



		J5

		160-pin, 10 mm male VITA 57 connector

		Samtec

		ASP-134604-01

		Samtec ASP-134604-01



		J6, J10

		Connector jack end launch PC gold SMAs

		Emerson

		142-0701-851

		Digikey J658-ND



		J8

		7-way SSW 2.54 mm vertical socket

		Samtec

		SSW-107-01-T-S

		FEC 1803478



		J9

		7-way sip 2.54 mm TH header

		Samtec

		TLW-107-05-G-S

		FEC 1668499





Table 7. Evaluation Board Models

		Product

		Ordering Model

		Sample Rate (MSPS)

		Resolution (Bits)

		Package Used on Evaluation Board



		AD4000BRMZ

		EVAL-AD4000FMCZ

		2

		16

		10-lead MSOP



		AD4001BRMZ

		EVAL-AD4001FMCZ

		2

		16

		10-lead MSOP



		AD4002BRMZ

		EVAL-AD4002FMCZ

		2

		18

		10-lead MSOP



		AD4003BRMZ

		EVAL-AD4003FMCZ

		2

		18

		10-lead MSOP



		AD4020BRMZ

		EVAL-AD4020FMCZ

		1.8

		20

		10-lead MSOP





Related Links


		Resource

		Description



		ADA4805-1



		0.2 µV/°C Offset Drift, 105 MHz Low Power, Low Noise, Rail-to-Rail Amplifier



		ADA4807-1



		Low Power, Low Noise and Distortion, Rail-to-Rail Output Amplifier 



		ADA4940-1

		Ultralow Power, Low Distortion, Fully Differential ADC Driver



		ADR3450

		Micropower, High Accuracy 5.0 V Voltage Reference



		ADR4550



		Ultralow Noise, High Accuracy 5.0 V Voltage Reference



		ADP7118

		20 V, 200 mA, Low Noise, CMOS LDO Linear Regulator 



		ADP7182

		−28 V, 200 mA, Low Noise, Linear Regulator



		ADM660

		CMOS Switched Capacitor Voltage Converter



		ADP2370

		High Voltage, 1.2 MHz/600 kHz, 800 mA, Low Quiescent Current Buck Regulator



		ADP5300

		50 mA/500 mA, High Efficiency, Ultralow Power Step-Down Regulator



		EVAL-SDP-CH1Z



		High-Speed Controller Board for System Demonstration Platform (SDP-H1)



		AN-931

		Understanding PulSAR® ADC Support Circuitry





		[image: image38.emf]

		ESD Caution 


ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.



		Legal Terms and Conditions


By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. (“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term “Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.



		©2016–2018 Analog Devices, Inc. All rights reserved. Trademarks and 
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